Transcript for Session 017

Listen to the podcast session, see resources & links:

http://chandoo.org/session17/

Transcript:

Hi there. Welcome to chandoo.org podcast session 17. This podcast is aimed to make your awesome in data analysis, charting, dashboards and VBA using Microsoft Excel.

In this episode, I have a wonderful guest with us who is going to share the 'Top 10 non-Excel tips for Managers and Analysts.' That's right - in this episode we're not talking about Excel. Instead, we are going to talk about the rest of the Office applications, i.e. Word, PowerPoint, Outlook and a few other things.

I am really glad to invite Paul Woods. I wish I could say that he is my friend, but the thing is that I met him online just a couple of weeks ago. So, I'm still getting to know him like you are. Paul Woods is running a website called http://thenewpaperclip.com. Those of you who remember Clippy or the paperclip from earlier versions of Office, it's that little animated paper clip that used to provide on-screen help and small tips and instructions while using MS Office. As a tribute to the Clippy, he names his new website as http://thenewpaperclip.com. But, the main reason that I am featuring him in our podcast is not because he runs that website (although it is a very powerful and useful website); the main reason has got to do with coincidences. That's right. A while ago, I received an email from Paul Woods. That was the first email I got from him. He might have left a couple of comments on our blog before that. That email said, "I feel like I should reach out to you because in our lives there are just too many coincidences." And then he went on to list several coincidences which made me realise that he and I are really similar. I replied back to him and we got talking. I invited him to be part of my podcast so that I could learn more about him and he could share some of his ideas with all of us on this podcast. So, without further waiting, let me invite Paul to this podcast. In this episode, we will actually talk about those coincidences, so if you are curious to know how his life and my life are similar, you will get answers to that in a few minutes.

Chandoo: Hi Paul, how are you doing?

Paul: Very well, how are you?

Chandoo: I am doing well, Paul. I am really happy to finally meet you through skype and do a podcast interview with you. I think this is one of the very first times that we are talking although you have sent me a couple of emails. It really sounded like a page out of a story book when you sent the email because you said that there are too many coincidences in our lives and we should probably talk to each other. Let me just re-cap your email so that our readers can know a little bit about you.
The email that Paul sent contained four bullet points. He asked how I was and then he mentioned a lot of coincidences:

1. Paul and I are both MVP’s, awarded by Microsoft for people who are working on their software platforms and sharing knowledge. And, we both became MVP’s in 2009 for the first time. That was a very strong coincidence. But, Microsoft awards hundreds of people the MVP status every year and brings them into the program. So, that’s not such a big coincidence.
2. The second one is that we both have websites focused on helping people get more out of Microsoft software. Again, that’s a good coincidence.
3. We both started off our own business. Paul started his business in 2010 and I also did.
4. The final one is really a tickle. He says, “We both are fathers to twins!” That was just someone like me living in Australia.

Paul: Yeah, and I found someone like myself in India!

Chandoo: I know one other MVP who has twins. - Fabris Remlinger - I’m not sure if you've heard of him.

Paul: The name is familiar.

Chandoo: He created an add-in called sparklines for Excel. I know he is a father of twins. Fabris is a good friend; he emails me once in a while. That was a good moment. I felt like maybe this is something that Excel MVP’s start doing - giving birth to twins! I really wanted to know more about Paul and see what work he is doing. It immediately struck me that the good way to do this would be to invite him to our podcast, talk a little bit about his work and gain a little bit of his knowledge, while we get to know each other. That’s how I invited Paul. Thank you so much for coming to this podcast, Paul.

Paul: It’s my pleasure; I'm looking forward to it.

Chandoo: Can you briefly tell us what you do and how you started this work?

Paul: It’s a long story. I'll give you the abridged version and not bore your listeners. I studied Information Technology and Marketing as a double degree in my undergraduate studies. So, I've kind of sat on the fence between Technology and Business right from day one. I've kind of flip-flopped between those two along my career. For a while I worked for the Queensland government, a State-government authority here, as a UNIX administrator. I was managing Solaris in a very technical role. Then I worked for Microsoft and did an internship with them for 12 months. I went from being a UNIX administrator to being a Product Manager (almost like a sales and marketing role) where we were looking at a few different things. It was back in 2005-2006 when Office 2007 and Windows Vista were coming down the pipeline. I was doing presentations for Chief Information Officers around the new user interface, the ribbon we were launching back then and trying to convince people that it was a good idea to upgrade from Office 2003 and earlier versions. I live in Brisbane in Australia. Brisbane has quite a rural office. So, I would have had to move to Sydney to continue with Microsoft. But, I have a happy wife in Brisbane and I would have an unhappy wife anywhere else, so we made the decision to stay in Brisbane and I went to a Microsoft partner called Data3 which is where I am today. It’s been about 8 years that I've been with them. On the side though, the way I kind of started with what the topic of today is really those conversations that I was having with the Chief Information Officers and the business people back when I was in Microsoft’s office in 2007. We are very familiar with the ribbon today, but if we think back
8 or 9 years, it was a bit of a mind shift for a lot of people. Even today, it is still a bit of a mind shift for people to wrap their head around how to use the design you see in the user interface. So, it's a bit of a hobby for my own self learning and to kind of make sure that I was capable of articulating what I wanted to talk about with these people. I started up a website where I could just blog about those different tips and tricks and that's what http://www.thenewspaperclip.com is about, which is the reason why I have been awarded the MVP award and really the reason why our paths have crossed today I guess. So, I started writing tips and tricks; I started off with really simple ones - the things that most people would be asking about, the things that most people would be challenged with. For example, simple things like how you undo in Word. It seems like a simple thing now, but back then when they removed the Edit menu from Office 2003, people didn't know where to find that button anymore. People were almost too afraid to ask their colleagues where that button was and would rather go to a search engine instead. It was really focused on short, sharp and quick solutions to problems that people came across as they transitioned to that new user interface. And, eight years later and probably 10 or 11 million visitors later, and after having written about 400 articles, I've kind of turned it in to something else as well.

**Chandoo:** Excellent, that's really good to hear. Can you tell us a little bit about the name behind the website.

**Paul:** It might be pretty obvious to a lot of people. When people think back to Office XP and Office 2003, there was a little character there called a paper clip or Clippy, and Microsoft killed Clippy with Office 2007 and took him out of the product. I thought, "No, this cannot happen. Clippy is my favorite." So, I was thinking of a name, and Clippy was all about giving that short and sharp advice and helping you through the process. So, I thought I would call it http://www.thenewspaperclip.com and see how it takes off. The legal people from Microsoft haven't come after me yet, so it seems to have worked.

**Chandoo:** It's a good name and I think it is one thing that people will notice right up front when they visit your website and that's something that you really want. I think that the very first time that I saw Clippy was in 1999. It was also the very first year that I got to spend a lot of time with MS Office. I was preparing a project report for my High School and we had to do it in MS Word and that's when you'd see this paper clip appearing out of nowhere saying, "It seems like you're typing a document," or something like that. We would all get curious and start playing with it instead of working on the report! We'd right click on it and press the animate button because it would make the paper clip do all sorts of silly things like fold itself into a letter or rotate and behave like a genie or something like that. It was good to see something like that in a serious software. It lightened the mood.

**Paul:** Absolutely. They had the puppy and the other characters as well.

**Chandoo:** Yeah, there were lots of them. Wasn't there an Einstein (the famous scientist) character as well?

**Paul:** Exactly.

**Chandoo:** I think Clippy was the most elegant of them all. It was a natural fit into the Office flow and I felt a little sad to hear that they were getting rid of it eventually.

**Paul:** Don't worry; Clippy is living on through my website! That was really the inspiration for my style
and the kind of content that I wanted to produce on the site. It was really focused on how to re-create the goals and outcomes of what Clippy was doing without being as annoying as Clippy was! I kicked that off in 2006. It ran for about 4 years. I would sit down and write about 20 or 30 pieces of content in one afternoon and then schedule them out over 6 months and slowly trickle feed them to the site, so that people had fresh content all the time.

While I was doing that, I was in a marketing role at Data3. I was in Marketing Communications as a team leader and focused on internal communication within the organization and external communication with customers and suppliers. Around 2009 or 2010, I started thinking that there is probably a business opportunity here to think about how people interact with my content and then apply that in a business sense. How can we build a services business that helps organizations [whether a Government department, a financial services organization, a School, a University, a local council or Water Authority] get more out of the tools that we've already invested in. We got lots of people, who were going to my website, asking really basic questions. That told me that there are a lot of people out there in the work force that don't know how to use Office all that well. They don't understand how to get the most even out of the basics. Everyone talks about people knowing 5% of the product and having no idea about the other 95% of Office. That's true if you are an advanced user. But, if you're the general population, you would probably have familiarity with less than 1% of the product.

If you look at Office 2007, I figured out that are about 200,000 different buttons that you can click throughout the entire product. No one is going to have that level of authoritative knowledge. I'm not going to claim that I have the knowledge to articulate every single one of those functions. The thing that was absolutely missing was making sure that people could authoritatively use 15 of those functions in Office, i.e. the 15 things that would absolutely make the difference in someone's workday. The idea was about getting people more out of the product that was already deployed, helping people adopt technology in organizations - we started off with Office because that's there in every organization in Australia at least, let alone the world. That's what businesses run on - Outlook, Word, Excel, PowerPoint etc. We basically built a business from 2010 to today. It went from me as an idea that I pitched internally to our Executive team. I told them that I thought we could make some money out of this at the same time. They gave me the blessing to start what we call 'Business Productivity Services' exactly 22 hours before my twin girls were born. It was like having my three children born all at once!

**Chandoo:** I think it's also interesting because when your organization supports you in your personal mission; it's the best of both worlds. You can enjoy the comfort and flexibility of your own work but, at the same time, you also have the protection and safety of a company taking care of your needs, helping you make better decisions and also supporting you in case you have some hardships in the journey.

**Paul:** There have absolutely been those along the way. And, that's something that myself and my wife thought about at that time. I thought it was a really good idea back then. Even now, I absolutely believe that it's a brilliant idea. It's a really good opportunity to work with customers to help them exploit what they've already invested in and help people get more value out of the technology. You'd be familiar with this since you have twins too - back then, there were other things that were on top of my mind - how do we keep making the mortgage payments, how do ensure we can pay the bills etc. - it really influenced my decision that I can't do this by myself as an entrepreneur, if I started from scratch. However, I could do it as an entrepreneur within an organization. I may not make as much money in the long term because of equity etc. since I'm still an employee, but the security of having that addiction to the
fortnightly pay check definitely helped as we were starting the family and the girls were growing up. It's probably worth another podcast episode to talk about entrepreneurship versus the idea of intrapreneurship and trying to build new things and try new things inside organizations.

Chandoo: Interesting. I think that's one of the big worries that all of us face especially at the stage when you're turning from an adult to a parent. The first time that we found out that we're having twins it was probably 60% shock and 40% joy because we weren't really expecting to have twins. We were hoping to be parents but our long term plan [at that point] was to have one child and that's about it. We were both working at that time and we knew that [professionally] it could be a hard task to raise kids and keep up with you work and other things. With rising costs and other things in India, it really felt that if you have two kids it would mean sacrificing a lot. Purely from an economic point of view, raising a kid is a big cost these days. We felt that we were not in a position where we could afford the luxury of having more kids. When the nurse told us that we're having twins, my wife and I were shocked, as it wasn't on or minds at all. Eventually, we felt very happy because we asked for one and we got two! That's twice the happiness! What's there to worry about? But then these thoughts arise in your mind - how do you support the family etc. We were both still working at that time and by the time the kids were born, I was already toying with the idea of quitting my job and starting a business. But, other things catch up with you - how do you pay for essential things every month etc. We didn't have a mortgage back then, so that was a plus point. However, we still had lots of monthly expenses. And my wife was on unpaid leave in order to take care of the kids for the first year. So, it was a huge transition for us. Fortunately, it all worked out. Today, I am happy that we have twins. It really multiplies our joy. Every time we see them, it brings a smile to our faces.

Paul: Except when they're fighting!

Chandoo: Yeah, except when they're fighting. Of course, you know that! They are at the right age now. They weren't fighting so much till they were about 3 years old because they were still learning about each other and playing with each other. But now, they're at a stage where they are fighting with each other and complaining about each other. My wife and I are like judges in a court trying to resolve their conflicts and see who's right and who's wrong!

Paul: Exactly. The interesting thing that I was thinking about as we were discussing this is actually a fifth coincidence! We haven't discussed this before the call, but I'm going to put you on the spot right now. I know that you've assigned yourself some challenges by taking on some pretty epic sporting events like your 200 km bicycle ride. I'm almost exactly the same. Cycling isn't necessarily my thing but triathlon absolutely is. I'm very much one of those people who set a crazy goal and see if I can attain it. Just recently, I've completed an Olympic distance triathlon which is a 1.5 km swim, followed by a 40 km bike ride and followed by a 10 km run. I think there's even more coincidences than we've discovered.

Chandoo: That's' very inspiring and interesting to know. Of all the sporting things that I see, it seems that triathlons are the highest you can go. There are more sports that have lots of hardship and endurance testing, but triathlon seems like something that requires a lot of practice and discipline.

Paul: If you want to do it well.

Chandoo: Most people are good at one or two things. I can walk or run and I can cycle. But, when it
comes to swimming, I tire myself very quickly. Even though I know swimming, I cannot swim for 0.5 km at a stretch. I do a couple of laps, take some rest and then I do a couple more.

**Paul:** I do the same thing. I just make it look like I know what I’m talking about, but I have no idea in reality!

**Chandoo:** Interesting. That’s good. Now let’s talk a little bit about the topic of our podcast which is *Top 10 non-Excel Microsoft Office tips for Managers and Analysts* [or anybody else out there]. I believe you have a list of tips. Why don’t you go ahead with them? After each tip, we can spend a couple of minutes discussing it.

**Paul:** Absolutely. I've pre-prepared this list for the podcast today. What I had at the back of my mind as I prepared this list was the things that will help podcast listeners take control of their day or help them get rid of all the frustrating tasks that they might do during the day which will help them get more time in their day. Out of this list of top ten things, there are definitely going to be things that you know about but there are also going to be things that you don’t know about. I’m not sure which one is which. So, bear with us as we go through it - it might save you 5 seconds a day or it might save you 5 months a year, depending on your job, what you do and how you use things. In the format that I’ve got here, there is actually one which is Excel related. I know that’s breaking the rules, so we’ll start with that first! I’ve got a few general Office ones that apply across the different Office products. Then, I’ve got a few for Outlook, a few for Word and one for PowerPoint. There’s also a special bonus tip at the end.

In my job as a Marketing Communications team leader, my primary job was to help communicate messages inside the organization and help people understand those messages at the same time. One thing that I’ve noticed with a lot of Analysts, people who are very good with data, people who are very good at slicing and dicing data in Excel, is that sometimes they aren't as effective in communicating the message that they want to communicate off that data. You may be awesome when it comes to Excel and we could argue for hours about which one is better - VLOOKUP or INDEX-MATCH - and, you absolutely know what you’re talking about. But, when it comes to communicating the concepts, ideas and the knowledge that you’re pulling out of the data to a Chief Information Officer, Chief Executive Officer or a marketer like me, it can prove really challenging.

I guess my first tip for Managers is to *make sure that you’ve got that basic understanding of Excel to the level where you can effectively communicate information.* So, I’m thinking of some examples here - being able to do simple graphs but not simply throwing every piece of data on to the graphs, only adding new information that is relevant to the stakeholder that you’re trying to influence in the decision making, potentially not having that chart or graph in Excel but putting it into a format that people are familiar with and people can understand whether that's a PowerPoint presentation or a Word document and using some of these features where you can link directly in to an Excel spreadsheet. A lot of people on this podcast, living in Excel all the time, will be thinking that this is really simple stuff and there’s no value for them in this. But, I guess, the simple thing to keep at the back of the mind is how you’re going to communicate the information, what decision do you want someone to make and what can you do to help them make that decision more effectively instead of just giving them all the information. *Prioritising what people need to know about is probably the one Excel tip that I’d give at the start of the list.*
Chandoo: That's a really good one to start with and I totally agree that we should use Excel and other tools as a means of communicating our ideas, visions, plans or decisions to the world, i.e. the rest of our colleagues, bosses or clients. Even though it might sound simplistic to say - 'use Excel to communicate' - it amazes me that every day many people fall into this trap of using Excel because they want to communicate. Sometimes people call me and ask for advice regarding how to learn a certain aspect or how to become good in Excel and most people are interested in knowing everything that is out there in Excel. I try to guide them that there is no point in trying to learn Excel. Instead, ask yourself and try to use Excel so that you can use it better for your work. There is a difference between these two. Learning Excel would probably mean going from one ribbon to another and figuring out what all those 2500 buttons do and figuring out some ways in which you can combine one with the other. If I want to say that I want to learn formulas, it could potentially mean that I want to learn all the 400 different formulas that are out there. But that kind of knowledge might be quickly useless for you, unless you are in a teaching profession or something like that. For a professional, especially a Manager or an Analyst, what matters the most is those critical 20-25 things that they use every day and use them effectively and use them in such a way that only their work is visible when you open Excel [and not the fancy bells and whistles]. I hope I'm making sense. I think that's really what you're also saying and that's good. This is the kind of approach that one should take if they want to use Excel better. At least this is how I used to work with Excel when I was employed as a full time Analyst. You should always ask yourself, "What can I use so that I can communicate my ideas better?" And, if it has to be PowerPoint or Word or something else, then be flexible and take your chart or table there, rather than sticking everything in Excel because that's your comfort zone.

Paul: I think, just to re-iterate this point, is what you mentioned in episode 16 [that I was listening on my way in to work this morning] - the people listening to this podcast are probably in the top 5% or top 10% of Excel users out there since you're listening to an Excel podcast - but, it's the other 90% or 95% of the workforce that really aren't that data literate. It's really surprising that even in this day, when there is so much technology and so many resources available for people to learn all of this stuff, there are so many people in the workforce who are data illiterate. We talk about this internally here at Data 3. Everyone is talking about this idea of Big Data and getting these huge data sets, slicing and dicing data, correlating data and making decisions based off it, is like a Utopia. You can find all these connections and unknown relationships and make profit for the organization and provide better customer service. That's brilliant. This whole other problem, which is probably bigger than Big Data, is what we like to call Little Data. A Manager sitting at a desk with Excel open and with just 17 rows of data there and they still can't slice and dice it to figure out the information they need. They can't correct the chart effectively to communicate the point they want to get across. I think that Big Data is an emerging trend that's going to drive all their jobs in the future. But, I think, that a much bigger challenge here is how to raise the level of data literacy across organizations and how do we solve the Little Data problem as well.

Chandoo: I agree. I think that Big Data is something that a lot of Marketing departments have picked up very quickly. But, it's not really that the data is getting big. Ever since the concept of databases was introduced and companies started tracking every little thing, one way or another they have been keeping track of an insane amount of data and probably a little more so these days because of the sources from which they can collect the data. The challenge always has been making sense of it, and not really the number of rows in your table. It's not that companies suddenly say that they need hundreds of millions of rows and that they can't really do with a million rows. For them, the biggest task is how to understand the data, whether it is 17 rows or 17 million rows. That's where [as you rightly said] data
literacy plays a very highly important role if someone has to sit down and understand what's going on.

Paul: Exactly. That's a lot of discussion around our first tip. Just to re-iterate it, remember how you want to communicate the information or the knowledge that you are creating through your analysis in Excel. That's really important so that people understand the point that you're trying to get across. Are you happy for me to move on to the rest of the list now?

Chandoo: Sure, please.

Paul: The next 2.5 or 3 tips are general Office ones. No matter where you are in Office - Word, Excel or PowerPoint - you'll be able to leverage these tools to take some redundant steps out of your workflow, help create new or better things, or to remove the frustration from your day. The first one isn't a new feature at all. I think that the earliest I've seen this feature is in versions of Word before Word6 which I think was in 1993. This feature has been in since day zero. It really surprises me, to this day, how few people know that it even exists, considering it's been the fourth button from the left on the toolbar or ribbon in pretty much every version of Office. It's a tool called Format Painter. I've run hundreds of workshops across Australia and done a lot of presentations and I always talk about Format Painter and it surprises me how few people know about it and the power of it. So, for those of you who don't know about it, you might have seen it on the toolbar or ribbon. It is a little icon that looks like a paint brush. The idea of Format Painter is something very similar to the idea of Copy & Paste. If you use Copy & Paste (Ctrl+C and Ctrl+V) for copying and pasting text in a document, spreadsheet or a PowerPoint presentation, Format Painter is pretty much exactly the same except that you're not copying and pasting the content, you're copying and pasting the formatting that's applied to that content. It starts to get very powerful. So, if you're using it for simple things like if you're building a newsletter for your local community group or for your internal social group at work and you've got this ridiculously horrendous heading that's bright red, italic, bold and with this fancy font and centered and you want to re-create that heading somewhere else in the document, it would be 5 or 6 manual steps. You'll set the font, set the font size, set the font color, set the alignment to centered and that kind of thing.

Format Painter lets you take all the formatting that you've applied, whether its character based formatting or paragraph based formatting, and then apply it somewhere else to another piece of content and copy that across. Hopefully that paints the picture of how powerful it is, but probably a more relevant example that everyone will relate to is that if you're in a Word document and you've got a bulleted list - a list of items in a bulleted list - and somehow there's always that one bullet that doesn't quite line up because you've hit tab at the wrong time or there's a hanging indent that's out of whack - there's always that one bullet and no matter how much you play with the ruler at the top of the page, you can't get it to align. Format Painter is a great way to solve that problem. What you do is that you select one of the bullets that you really like and that looks really good, click on Format Painter and then you paint the formatting on to the dodgy bullet that you've got there. And, you've instantly fixed up your list and all those bullet points are aligned perfectly and you can move on with the task at hand. So, Format Painter is the one thing I'd recommend everyone to get familiar with. If you're a bit more advanced, there are some more things that you can do. If you hold down Ctrl or Alt, it locks it down to character based formatting or paragraph based formatting, but you don't need to know that level to get the most out of Format Painter. Out of all the people that I've talked to, probably 20% of the people know about it and 80% of the people don't. I can see their jaws dropping and people getting really excited about it as soon as I start talking about bullet lists in particular.
Chandoo: Excellent. In fact, Format Painter is one feature that is really designed to save time for people rather than achieve anything on the screen. I totally agree with you. I demonstrate this feature many times in my courses and my live classes, and I always hear a lot of loud gasps and "Oh, you can do that" kind of feedback immediately. So, Format Painter, for me, ranks right up there in terms of the skills that you need to pick up very early on in your journey in to using Office for your day to day work. Excellent tip!

Paul: And, my favorite part about Format Painter is that people always ask, "When were you able to start to do that? How long have you been using this feature?" And, I say, "Well, when I was 7 years old!" They're like, "Oh boy, I've wasted my life!"

Chandoo: That's good. It just demonstrates what you said very early on. There are these 2500 buttons in Excel alone and when you combine the other softwares like Word, PowerPoint and Outlook, you're probably talking about 10,000 little different things that can be done on the screen. And not many people get to experience even 100 or 1000 of them in their day to day lives. We tend to give up on all these things that are out there. And, many people also wonder if it's worth learning some of the other things. But, it pays a lot to pay some attention and learn 1 or 2 things at a time instead of trying to understand all these 10,000 things, so that you can constantly add to your chest of tools and deploy them whenever they are needed.

Paul: Exactly. There's a really nice third tip that I've got on the list and again it's about Format Painter. When I run those live sessions and I am sure when you run your live sessions, the interesting thing is that with people who know Format Painter, the next question I as them is, "What is the most frustrating thing about Format Painter?" Almost everyone says that the most frustrating thing is to keep going back to click Format Painter every time you want to apply the character formatting or paragraph formatting through the document. Just to give those who aren't familiar with it a context, as soon as you use Format Painter to paint a line of text, the Format Painter basically turns off the cursor. You have to hit Format Painter again and apply it to your next line or paragraph. But, something that a lot of people don't know about - only 20% of all the people who know about Format Painter know about this next feature - and that's about double clicking Format Painter to keep that formatting on your cursor and being able to go through your document one line at a time, one phrase at a time or one paragraph at a time and continually paint the formatting until you hit the escape key. So, that's probably another thing that if you're familiar with Format Painter, you've just learnt about this as well. And for those of you who know Format Painter and get value out of it, double clicking on Format Painter to keep the formatting on your cursor throughout your document, is absolutely one of those life changing moments that we find in all those live sessions that we do.

Chandoo: I agree with you. I think the feature to lock Format Painter (by double-clicking it) is another feature that not many people know about. However, the moment they find out about it, they also see how much time they can save and how easy it is to work with these once you figure out how they are set up and how they are meant to be used. I believe that this ability to double-click to lock certain things is universal in many places in Office and not just with Format Painter. Although there are not many things that you really want to double-click and lock; I believe that certain things like drawing objects like when you’re drawing lines, you can lock the drawing mode to the line tool or rectangle tool or whatever you are drawing multiple instances of.
**Paul:** Yeah. It saves the mouse movement of going back to the top of the screen and collecting that square or line again.

**Chandoo:** Exactly. This is also very useful in the new Office set up. In earlier versions, you had the floating toolbars. So, if you found yourself constantly drawing rectangles or squares, you could move the drawing toolbar right next to your slide and reduce your mouse movement. But, with the new Office, it's all locked up way up there in the ribbon and you can't move it around. You cannot bring something to your slides. So, every time that you want to do something, you need to go back to the ribbon. And, if you've switched the ribbon to the 'Home' ribbon or something, you need to go back to the other ribbon in order to access that feature. This creates a lot of mouse travel, whereas ideas like double clicking to lock will save you a lot of time and quickly get your work done.

**Paul:** Absolutely. Format Painter is my all-time favorite feature of any Office product. I use it every single day and, hopefully, a lot of your users will start using it every day as well.

Let's move on to the fourth one. This one really comes back to the first one where we talked about communicating ideas and how do you communicate ideas effectively. Whether you are in Excel, Word, PowerPoint or Outlook, the ability to insert a screenshot into your document and to be able to do that really quickly and effectively to enable you to communicate your ideas visually, based on something you've built in a word document or found on the internet. Traditionally, a long time ago, keyboards had the 'print screen' button on it and if you pressed that button, nothing would happen. You wouldn't see any feedback on the screen or anything like that. All that did was place a screenshot of your screen into the clipboard, and if you used 'Paste', it would paste it in to your Word document or Excel document or something like that. But, nobody really knew about that. Nobody really knew that there was a quick and easy way to do that.

It was in Office 2007 or Office 2010 that Microsoft inserted the ability to insert a screenshot into the ribbon. If you go to the Insert tab while drafting an email in Outlook, or a spreadsheet in Excel or a Word document and if you're on the Insert tab and if you look across a little bit, you'll see the ability to insert a screenshot. What that gives you the ability to do is either insert a full size clipping of an application that you've got open - so it'll automatically give you a gallery of all the different windows that you've got open - and you can select and insert it in to your document with basically 2 clicks or you can do a screen clipping which enables you to basically drag and drop the cursor across the screen and just identify the bit of the screen in the last application that was active on the screen and drop that directly into your spreadsheet or PowerPoint presentation or Word document. Some of the examples that I can think of that would be useful to the listeners of this podcast would be - if you're building a model or chart and you want to get some quick feedback from a Manager about whether you're in the right direction, instead of sending him an entire 5 MB or 10 MB or 1000 MB document with lots of links in it that would be complicated to send across to that individual - what you can do instead is take a quick screenshot of that chart or model that you've built and drop that directly into your email. You just need to add the ‘to’ line and the subject line and a bit of commentary in the body and go to Insert>Screenshot and drag across the chart or model that you want to share with that person and send it. It's a really quick and easy way to articulate things that are potentially difficult to send to somebody else.

**Chandoo:** I totally agree. I think the screenshot is a really cool way to quickly share information. And, it's low friction; once you make it and send it or put it in a document, it's really light and easy to use. That
brings me to one example that's somewhat funny but [I think] also appropriate to share. This is something that I saw when I was working at a client location way back in 2008. We had a Project Manager and we’d have presentations every week where she would talk about where the project was heading, what we needed to do to catch up and all those things. She would show her project presentation and she was somebody who worked with PowerPoint, Excel and Word day in and day out. Since she was a Project Manager, her work was really about communicating and coordinating with people, attending meetings and making decisions. That’s what her work was. She wasn’t really developing code, testing it or any of those things. Rather, she was the Manager overseeing the project.

We would naturally think that she’d know her way around these things. [Not to throw bad light on her but just to showcase how people can be when they lack some important knowledge] She would show this presentation where the project progress would be depicted as a nice chart but she had no idea how to embed that chart into PowerPoint. She would open up Excel, take a screenshot and put that screenshot into the PowerPoint. While I agree that screenshots are a very quick way to communicate, there is a limit on how far you can take them. In a presentation or a meeting, many people would probably want to explore the chart a little more and zoom into it more etc. Since a screenshot has low fidelity, what eventually happens is that it is not clearly visible sometimes [especially in a presentation scenario] or doesn't show the entire picture since you just took a screenshot so whatever is on your screen is depicted but there could be more rows beneath it or on the side of the screen that are not part of the screenshot. And, it also shows a lot of unnecessary things like the ribbon, taskbar and Start button and all those things which are, in a way, eating up space on the presentation.

The moment that you mentioned screenshots, that vision popped into my mind for some reason. So, I just wanted to say that while screenshots are an incredibly powerful way to share quick information, there are also other ways to do it. For example, if you want to share a chart, you could copy the chart in your mail or your presentation. You could also use pasting options - when you are pasting, you are given a choice of whether you want to paste it as is or as a picture - which is really a screenshot of only the chart. That is a very powerful way and it keeps the chart fidelity very high, i.e. you can scale it and the chart will respond nicely, it won’t get distorted etc.

Paul: I think the main point of all that is really just going back to the first point - what are you trying to communicate and what do you need to communicate, and how to make a decision on how to do that based on that. If you’re walking into a Board meeting or an Executive Management meeting where they are going to ask questions and you need to be able to work through that data really quickly and efficiently to find the answers for the people asking the questions, then a screenshot may not be the right choice. You might consider a dynamic link to your Excel spreadsheet or just have your Excel spreadsheet on hand in such instances. However, if it is short and sharp feedback, then a screenshot has its place. I absolutely agree with everything that you just said there.

Chandoo: Let’s move on. What’s the next one?

Paul: The next one is really the end of the general Office stuff. We're going to look at Outlook for a second. I've got a couple of Outlook tips to really help you manage that flood of email that we get all the time. I know that I would love to have the system set up that you have set up where you set the expectation that you can check your email once a week and respond to emails that came in since. Unfortunately, in my role, and the roles of a lot of people listening to this podcast, is that we don't
necessarily have that luxury of being able to set when we communicate with people. So, the next couple of tips are really about how to manage some of that flood of email into your inbox and more importantly, how do you manage your attention associated with them.

And, one of the things that I recommend for everyone [unless your primary job is responding to email] is to turn off every single notification in Outlook. I hear a few people saying - "What if I miss an important email?", "What if I have too many emails come in there?" - Just trust me on this one. The fact that you've got a notification every time an email comes in, whether it's a sound or a pop-up or having your cursor show a little envelope when an email arrives or all those little notifications [which I like to think of distractions really], distracts you from your train of thought or what you're working on at that time. So, if you're working on building a model in Excel or if you're working on building a business case for one of your Managers and you keep getting these constant notifications ringing in your ear or popping up on the side of your screen, it's going to distract you from your ability to complete a really good outcome [whatever you are building at that time] and you're not going to be able to focus on what you really need to focus on. You're not going to be able to focus on the email response that you probably need to put some focus into. And, you're not going to be able to focus on the document or the deliverable that you're working on as well.

The way that I like to manage it is that I like to batch my emails. I like spend an hour at 10 o'clock in the morning processing my email and going through my email and at those times, I don't want to be distracted by anything else coming in at those times, since I have to personally manage my email. In order to turn off your notifications, it's not as difficult as you might think it is. All you need to do is go into to your Options within Outlook. If you're in Outlook 2013 and if you go in to Backstage View where you can see File>Options and click on it, a little dialog box will appear. And, it's very similar to get to that in Office 2010 and Office 2007. In earlier versions, if someone has still got Outlook 2003, you need to go into Tools>Options. Once your Options dialog box appears, you'll see a few different options on the left hand side - general, mail, calendar, people, tasks etc. - if you click on Mail and then about 3/4th of the way down the first screen you'll see a section called Message Arrival that has all these checkboxes that say 'play a sound when new messages arrive', 'briefly change the mouse pointer', 'show an envelope icon in the task bar display' etc. My one recommendation for you, when it comes to Outlook, is to uncheck every single one of those boxes so that you can focus on the task at hand and then put the focus into email when you want to do it, and not be driven by your inbox and when emails arrive. Take control of your own work.

Chandoo: I just did that in my Outlook! Ha, ha! I have a couple of different email accounts and I use Outlook just for my personal email account. This is something that nobody knows and this is where I get my bank statements, personal stuff, and my personal emails from friends etc. So, I did that because [as you rightly said] getting an email when you're tuned into a certain task can be a huge distraction because that'll take you off the tracks. It might be 10 minutes or 2 minutes or 2 hours before you come back and resume work.

Paul: Exactly. Coming back to one of the points mentioned above which is 'what if you miss out on an important email', you've got to think of it in this way that if it were really important, someone would come and talk to me face to face or someone would pick up their phone and talk to me using their voice. If someone is sending an email then it isn't really as urgent as they might think it is. There are other ways of getting hold of you. As soon as you get that concept into your head then it's really comfortable.
I'm really comfortable letting emails sitting there for days potentially. And, I'll respond to things as I can and when I can put the focus on them and I'll triage the emails a little bit - I'll respond to things that are higher priority for me than some other ones. **Turning off those notifications changed my life. I could take control of my work day.**

**Chandoo:** I really think that email is a distraction these days. When it was launched, there were far fewer emails than today and it creates a huge bottleneck for us if you want to accomplish something or do something in a very focused way. So, yeah, turn it off because you have control that way. You get to batch your emails once or twice a day, depending on the nature of your work. It'll leave you a lot of freedom and you get to do whatever you want to in between.

**Paul:** Absolutely. The next tip which is the sixth tip in the list is one that's about taking conversations out of email and turning them into real world conversations. Everyone will be familiar with this scenario where you've asked a question of someone and then you've got this email conversation that keeps going backwards and forwards. There might be 5 or 10 or 20 email backwards and forwards between an individual and a group of people and you keep going round and round in circles on email. Every now and then everyone gets frustrated and says, "Why are we wasting time? Let's get together and have a meeting about this. Let's get ourselves into a room or on a phone call and talk about what we're talking about on email here."

Traditionally, what people would normally do if they wanted to do that is find a time to set up a meeting, go into the diary and start a meeting request, type in the names of the people who were in the email thread in the 'to' line, add a subject to it and maybe even copy and paste the contents from the email into the meeting request, and then hit send. I'd do that at least 2 or 3 times a day, potentially, depending on the level of email and the topic. It would take a lot of time as it's a 7 or 8 step process by the time you find the meeting room, set the subject, set the 'to' line, copy the content etc.

From Outlook 2010, Microsoft included a new button called 'reply with meeting'. This is exactly the same as your reply button, but instead of replying with another email, it replies with a meeting request. What you get when you click 'reply with meeting' is that it'll automatically put everyone into the 'To' line, add in the subject line and add the email content into the body of the meeting request as well. So, instead of having to copy and paste and type those names in, you've got a meeting request populated with all the information that you need straight away and then you just need to type in a day and time to be able to set up the appointment and then hit send.

So, if you want a quick and easy way to take an email conversation and turn it into a real life meeting with someone or a group of people, 'reply with meeting' is absolutely the button that you need to use. To find the 'reply with meeting' button, if you're on the Home tab in Outlook, look at the space where you reply, reply all and forward buttons are, and there will be a little button beside that that looks like a little calendar with meeting beside it. That's the 'reply with meeting' button. If there's one thing that's probably changed my life a little bit less than the email notifications, but still had a significant impact on my workflow, it is the 'reply with meeting' feature.

**Chandoo:** I think that's a good one. I don't remember the last time that I had a meeting since I work for myself, but earlier, the moment I'd see a meeting request in my inbox, I would feel like someone is putting an injection in my arm and draining out some of my energy. That's the kind of feeling I'd get in
meetings, even though they are necessary in the corporate world. Everyone needs to go to a place, be brought up to speed and not everybody gains the same amount from the meeting. But, you have to be there. About 85% of the time I'd feel like it's a pure waste of my time to be sitting there and hearing all the deliberations. Very few times does a solid decision get made in such scenarios. Most of the time it's just a lot of back and forth and the decision to meet again.

Paul: I wish there was a button that said 'only show meetings that are going to be worthwhile!' Talking about meeting requests, this is my bonus tip. It’s not one of the ten, but it’s one of those not well-known things that you can do with Outlook which will absolutely change your life when you hear about this. A lot of your podcast listeners must be probably like me. I am horrible with dates. If you ask me what the date next Thursday is, I could not tell you! I'd open up my calendar, put my finger up on the screen and count across the days to Thursday and then drop down a row to get to the date. I’m really horrible at figuring out what dates are. If you’re trying to set a meeting request when you’re on the phone with someone or when you’re having a conversation with someone you’re trying to negotiate a time with, for me, I almost have to stop what I am doing in my tracks and try to figure out what that date is in order to respond to that person.

But, there’s this really nice feature in Outlook that hardly anyone knows about. If you are new to this feature, I can guarantee that the very first thing you'll do is go back to the office and show everyone else this tip as it's absolutely brilliant. In your start date for the meeting request when you've got a meeting request open, you can use the calendar picker to pick a date or you can just put your cursor into the start time date picker box and type in when you want that meeting to occur. So, if I said that I want that meeting to occur tomorrow, all you need to do is type in tomorrow and hit enter. It'll put in tomorrow's date! If you're on the phone and you decide to meet in a week's time, instead of going to the calendar picker and selecting the date from that, I can just type in 'one week' and it'll automatically populate that start time with the date that's one week from today. You can do this with one month too and put in fixed holidays like Christmas day etc. You can even put in yesterday even though I’m not sure why you’d want to do that! It’s a really quick and easy way of taking that next step of the mental process of figuring out what a date is and quickly typing it into the start time and moving on and getting the meeting request into the calendar.

Chandoo: Wow! I just tried to create a meeting request to test this feature as it sounded like something really cool. You’re right. I typed in 'day after tomorrow' and it changed it to 14 August which is the day after tomorrow. This is a really cool feature that not only makes you feel good about knowing this, but as you use it, it kind of removes a lot of extra mental processing that is purely unnecessary.

Paul: Yes, absolutely.

Chandoo: It's a good one. I don't know what else to say. This is something that I find really interesting to use.

Paul: If you want to impress your boss, that's a great one to use! It shows your Office skills to the people at work. It's a really good one. Let's move on the next feature. That's enough about Outlook. Let's look at Word for a second. A lot of people have to build reports and documents in Word. One of the things that a lot of people do is that they'll start working on a document, type in some headings and potentially add some content and kind of build the structure of a document as they build it. One of the lesser
known features of Word which is really helpful when you're trying to build a structure for a document and lay out what the headings are and that kind of thing is to use the **Outline view**. The Outline view enables you to type in the headings that you want to appear in your document almost in a bulleted list of input. It could be an executive summary, introduction, chapter 1, chapter 2 etc. if you're typing an academic report. Or, if it's a business report, it could be executive summary, rationale for the project, the project steps and the outcomes that we'll get. You can type in those headings using the Outline view. What the Outline view does is that it automatically applies the right styles based on the hierarchy of applying that Outline view, and then when you switch back to the Normal view, all your headings are already there and all you need to do is add in the text to one of those sections. So, switch to the Outline view by going to View tab and click on Outline. You'll see this bulleted view inside Word where you can start typing in your headings and you can set the hierarchy of those headings. If you want a sub-heading, for example, just press Tab to indent that heading and it'll automatically apply the right styles. When you switch back to your Normal view which would be the Print Layout, all those headings will be in the right spot, and you can start dumping the content in to the document and crafting the prose that you're trying to get in to the document as well.

**Chandoo**: Interesting. This would be something that I would also use. Last year, when I was writing my very first e-book for selling on Amazon, I spent quite a bit of time in Word writing that book. I kind of forgot how to use Word over time because I was spending way too much time with Excel and PowerPoint and Word is something that gets side-lined once you're in a position where you don't create a lot of documents. I used to know quite a bit of Word back in my college days when I had to type a lot of project reports, business cases and stuff like that. But, once I started my work, it was Excel and PowerPoint all the way. I was learning a lot of Word last year. This is something that I could use very well in my upcoming projects because, as you may know, when you're working on a book, the very first thing that you do is prepare an outline. And then you start working from that outline and go into individual chapters and build the chapter structure. The ability to just work on the outline and then switch back to the Normal view, to develop the content, is really good to know.

**Paul**: Absolutely. And, my eighth tip is that when you are in Word, it is really worthwhile to get to know **how to use styles effectively**. A lot of people might not know what styles are but they would have seen them before. If you are in the default view in Word and you look at the ribbon, you'll see that big box in Word 2007 or later, where you've got heading 1, heading 2, heading 3 and there's all the different kinds of formatting for each one of those headings - that's basically your styles gallery. You can change the design of those styles; you can update the fonts, colors and sizes in them. But, that's probably not the most important things about styles. You can make a heading look the way you want it to look. If you want heading 1 to look bright yellow, with a black background, with size 73 text, center aligned and all that, you can do all that with styles. However, it's not the most important thing to know about styles.

Styles automatically insert bookmarks throughout your document so that you can create some things really quickly and efficiently when you're trying to tidy up your document and prepare your document for distribution for whoever you're communicating with. For example, if you use styles throughout your document for heading styles like heading 1 for headings, heading 2 for sub-headings and heading 3 for sub-sub headings, it enables you to very quickly **build a table of contents based on those headings**. If you went through and created your headings by just using the bold feature and increasing your font size, you couldn't automatically build your table of contents. You need to use styles to do that. If you're using styles in your document - maybe you've used Outline View to create those headings or you've used
heading 1, heading 2 as you've applied it to text in your document - then you can create those really important things like tables of contents or be able to link directly to other sections in the document. If you're creating an electronic document versus a printed document and you want it to say that you can find more information about this in Section 3 of this document, then you can insert a hyperlink and the heading will automatically appear along with all the things you can choose to link to when you insert that hyperlink.

Again, getting used to styles is really important. The other key thing with styles is that if you have lots of headings throughout the document and if you've used heading 1 as a style, and if you wanted to update what all those different headings look like, you just need to do it once by just updating the style. You don't need to go through every single heading and manually update it as you would need to if you don't use styles. There are lots of benefits to styles. The one thing I'd recommend in Word is to make sure that you get to know how to use styles. Make sure that styles are your friend and you use them effectively because they'll save you a whole lot of time when you're preparing a document for distribution.

Chandoo: Yeah. I have nothing to say other than to agree with this because I have found incredible benefit by using styles. Every time that I struggle with something, I realize that it's because I haven't set up a proper style or I am just running around in circles instead of simply using a style. So, you're absolutely right. It helps you in many ways. In fact, sometimes I feel that compared with Excel, Word has so many more features. You can easily get lost in Word! Maybe I don't feel like that in Excel because I use it quite often. But, even back in college when I was using Word every day to prepare documents, sometimes I would find myself manically searching across the menus or the ribbon to figure out a command. And, I would lose 15-20 minutes just to figure out the right one that would help me in that scenario. So, Word has so many more features. It helps a lot to understand these powerful ones like styles, Outline view and these kinds of things so that you can stop wasting time.

Paul: Yeah, exactly. We're in the home stretch now. There are 2 more tips in the list. Tip # 9 is around PowerPoint. It's really about using PowerPoint to share information and share your message with people outside of your workplace. Everyone is familiar with using PowerPoint in a meeting room. You connect your laptop or PC to a projector and project your presentation on to a big screen and everyone in the room sees what you're talking about and gives you a big round of applause at the end of the presentation. Everyone is familiar with that. But, what if you want to share that presentation or share that content with someone who is in another office in your organization, the other side of the city, another part of the country, a different country or on the other side of the world? There are options out there to do this. You might use a third party tool like GoTo Meeting or you might use Microsoft's link offering screen sharing to be able to share your screen and for people to see the presentation you are delivering. But, there is probably some risk associated with that as well. So, you need to ensure that the person on the other end of the call knows how to use that tool, log into the tool, and access that screen in the first place. This might seem pretty simple on the surface, but for somebody who hasn’t done it before or for someone new, it is a difficult proposition.

Chandoo: Yes, that's right.

Paul: There is another option that's really easy and I use it all the time. It's being able to present your PowerPoint presentation online through a web browser. What this enables you to do is that you click on a button within PowerPoint and it'll ask you to login using your live ID or your Microsoft ID (your
hotmail ID) and then it basically takes your PowerPoint presentation, packages it up and sends it off into Microsoft servers and then gives a link back to you. All you need to do is share that hyperlink with someone - you can email it to them or instant message it to them or whatever - and, as soon as you hit 'start slideshow', anyone who has access to that link can watch your presentation through their browser.

It doesn't have to be Internet Explorer; it could be FireFox or Safari or a mobile phone browser. Everyone clicks on that link and can see that slide that you're currently presenting. When you click 'next' on that PowerPoint presentation, their browser will automatically update with that next slide. It is a very quick and easy way to share your presentation with someone, whether that's one person, a group of people or a whole audience of people. I'll give you a real example of where I've used this. I've presented a number of times at Microsoft's TechEd conference here in Australia. And, whenever I deliver a presentation, I'll set up this PowerPoint broadcast so that people in the audience who have their iPads, computers or laptops can view them on their devices instead of looking at the presentation on the screen. Everyone in the audience is able to have a view of the slides on their devices right in front of them. And, all that I need to do is put up the URL on the first slide and anyone who wants to type in the URL (which is a shortened URL like a bitly URL or something like that) can do so right in their browser. There is no authentication or anything like that. They can just see the presentation. It's a really simple and effective way to share a presentation. Another way that I've used it as well is on a sales call. A lot of people on this call might be in sales or Sales Managers or people that associate themselves with other organizations. PowerPoint is a big part of sales - getting an idea across and getting a customer convinced about the vision you're creating for them - as they're parting with their cash to realize that vision. I use PowerPoint broadcasts quite often when I am having a conversation with a customer who might be on the other side of the country. I live in Brisbane and I have customers all over Australia. My most distant customer might be in Perth which is about 5.5 hours by flight from here [about 4000 km] and I don't get over there very often. But, what I do is that I can still share my ideas with my customers and have a voice conversation on the phone and have the PowerPoint run in front of them. It gets through their firewalls and you don't need to set up any fancy software on their end and they don't have to have their computer locked down or install anything on their end or anything like that. It just shows them the slides on their screen and really quickly communicates things. To be able to set up a slideshow broadcast in PowerPoint 2013, click on the File menu [the backstage view] and go down to the share button and you'll see a few different options there. You want to click on 'present online'. In Office 2007 and Office 2010, I think this is called PowerPoint slide broadcast, instead of online. It gives you the option to present online using the Office presentation service which is a free public service that allows others to see your slideshow in a web browser. If you have other tools, for example if you are in a corporate environment where you have Microsoft link installed, it'll give you the option to use link here as well. But, in this case, we're talking about the simplest and easiest way to share the presentation with the easy Office presentation service.

Chandoo: Excellent. I think this is something that I am going to use in my next live class as well. As you rightly said, when I am doing a live class, it usually happens in a big room and sometimes the people who are sitting in the last few rows have difficulty seeing the slides that are projected.

Paul: Yeah, someone's head might be in the way or that kind of thing.

Chandoo: In some training classes they have the option to provide 2 computer monitors per delegate. One computer monitor just replicates my screen and so they don't have to crane their necks and see
what's on the projector. However, in many places there's just one PC or laptop. So, this helps me incredibly as I can just choose 'present online' and share that URL with the people in the class so that they can immediately see the same slides on their computer and listen to me. I'm going to use this. I didn't know this is so easy. To be honest, this just proves that even though there are so many buttons in Office, we don't click them often.

**Paul:** Yeah, absolutely. They're not really getting in the way!

**Chandoo:** That button was there all the time but I never really gave it enough thought to see what it does and how it can be useful.

**Paul:** Absolutely. It's a tool that I use at least once a week sharing ideas with customers across the country and internationally as well. It's really effective. You can get on a phone call just as you normally would, just as we are now on Skype or through a direct dial phone number, and you can click the slide [you don't need to send them the file in advance and tell them to click to the next slide]. You don't need to worry about all that because when you click to the next slide, their screen will automatically update. There are a few caveats to this one, just to make sure that everyone is crystal clear. It's not very good if you've got video embedded in your PowerPoint presentation. It won't play the video; it'll just show you the opening frame of the video. So, if you want to share video through a PowerPoint presentation then this isn't going to work for you. Likewise with audio. If they're just purely static slides then it's a great way to do it.

Probably the most relevant caveat for people in this podcast is that if you have an embedded Excel spreadsheet or a chart that is linked to a spreadsheet and you updated that spreadsheet after you've started the slideshow, the numbers won't change. So, once you hit the start slideshow button, it's basically static from then on and you can't make any changes.

**Chandoo:** What about animations and things like that?

**Paul:** That's a good question. I don't use slide animations that often and so I'm not actually sure of the answer to that. Let's say no, just to be safe. And, if it does work, we'll be pleasantly surprised.

**Chandoo:** I think if it's in the same browser then probably not. I've never tried this myself so I don't know for sure. I'll play with it sometime this week.

**Paul:** Just have a go at everything that we're talking about in this call. Discover it and try it out because you might be surprised how quickly you understand what we're talking about and the value it applies in your workday. And, you might discover some new things as well. All right, that was number 9.

Now on to number 10 which is the very last tip of the call. It's not really a tip; it's more of a recommendation. It's about this whole idea of **OneNote**. OneNote is an application that may or may not be installed on your computer in the past 10 or 11 years. We first saw OneNote appear in Office 2003. Sometimes it was included in Office Professional and sometimes it wasn't. If you're buying Office 2013 Professional Plus at the moment, it comes with OneNote. And, if you're buying the Home and Student versions of Office, it comes with it too. If you're subscribing to Office 365, it comes with it as well. OneNote is basically everywhere in Office now. The one non-Excel tip that I'd give to Managers to wrap
this up is to get to know OneNote and start using OneNote as your digital notebook. A lot of people look at OneNote and they don’t understand how to use it. They don’t know how to integrate it in to their workday. There are a whole different number of ways in which you can do this.

It’s probably worth an entire podcast episode talking about OneNote and how you can leverage it in your workday. But, I’ll give you some examples of how I use OneNote. I use it as a reference for all my notes from meetings. So, if I’m going to a customer, I’ll have a section of my OneNote notebook for that customer and every time that I have a meeting with them, I’ll add a new page to that section where I can type notes into OneNote and electronically capture all the different things and discussions that I talk about with customers. I could absolutely do that with a paper based notebook. But, with a paper based notebook, I don’t get the advantage of being able to search really quickly through all those notes. It helps in sharing information with other people. For example, I might take some meeting notes in OneNote and then I could directly email those meeting notes to everyone who was in the meeting without having them transcribed into a different application like Outlook or Word or something like that. There are literally hundreds of things that you can do with OneNote. How to integrate them into your workday is basically completely up to you. If anyone on the call has used or is familiar with David Allen’s ‘Getting Things Done’ methodology, OneNote is a great tool to manage your inbox, your active projects, your someday maybe’s and all that kind of stuff in the system. If you just want a digital notebook to take notes [really simple notes in the same way that you would use a normal notepad], it’s a great tool for that as well. Again, if you have some spare time and there is something that you want to explore, I’d recommend investigating OneNote and looking at how you can integrate OneNote into your workday. It would be something that would be useful for everybody in the podcast.

Chandoo: That’s a good one to close the ten tips. I think that any kind of note tracking device, whether you are using OneNote or a good old fashioned notebook or something like that, is always a good idea because it gives you a place to keep the ideas that are floating in your mind and refer back to them. Back in school days, we were encouraged to write things down so that we could memorise them better. Most of us tend to think that we’ll remember things and don’t have to write them down, but if you write it down, you’ll remember it better. That’s where using OneNote or a notebook or anything else for that matter is always useful. Especially as a Manager or an Analyst, on any given day, you have between 20-100 different things happening in your work life. So, it’s always a good idea to take notes and compare them from time to time so that you can make better decisions or be informed when you walk into a meeting.

Paul: Absolutely. That’s my top 10 list. There are probably another 30-40 things that I could add to that list. But, I thought this would be a good place to start. Some of it is high impact stuff. Again, some people would know some of that stuff we talked about. But, I am fairly sure - actually, I can guarantee that everyone would have learnt something new from that list today. Hopefully, that’s been valuable to the listeners.

Chandoo: It has. I have learnt quite a few things. For example, I didn’t know that you could present online so easily. That’s something that I’m definitely going to try. I didn’t know that we could turn off notifications so easily in Outlook. I am really surprised to see that we can type in plain English when you want to start a date as in ‘I want a meeting next week’. I just type that to translate into a date automatically. So, this is all good stuff and I am definitely sure that many of our listeners will find these top 10 tips incredibly useful. I hope they will get to implement some of these as soon as possible so that
they don't forget. Thank you so much for sharing these, Paul. If people want to know more about what you do and learn about things like this, where should they go?

**Paul:** There's a whole list of places to go. Let's talk about the ones from where you're going to get the biggest impact. If you're interested in the kind of content that we talked about today in the podcast, the website is [http://www.thenewspaperclip.com](http://www.thenewspaperclip.com). Outside the website, you can follow thenewspaperclip on Twitter. It's @thenewspaperclip. And, we've got a facebook page which is [http://www.facebook.com/thenewspaperclip](http://www.facebook.com/thenewspaperclip). That's Office tips and tricks. There's about 450 pieces of content there. I regularly post the best content from all the different articles on the social media channels - the ones that are getting the most hits. If you want to get regular update on the social media channels, you can subscribe to our newsletter at [http://www.thenewspaperclip.com](http://www.thenewspaperclip.com). If you are more interested in my life story as well as some of the other things that I do - I also blog at a separate spot which is [http://www.paul-woods.com](http://www.paul-woods.com) or you can follow me on Twitter which is @paulwoods. You can follow along my journey as an entrepreneur, running an Office tips and tricks website as well as sharing some of the things that I know with people like you.

**Chandoo:** Thank you so much Paul. I'll definitely link to these websites so that our listeners can find more information from [http://www.thenewspaperclip.com](http://www.thenewspaperclip.com) and [http://www.paul-woods.com](http://www.paul-woods.com).

**Paul:** Perfect.

**Chandoo:** Thank you so much for joining me all the way from Brisbane. It is a pleasure having you here. I really appreciate you for compiling this list of Top 10 non-Excel Office tips. I am hopeful that our listeners will enjoy these and get to implement many of these as soon as possible.

**Paul:** My absolute pleasure. Thank you very much.

**Chandoo:** You have a great day ahead. Thank you so much Paul.

**Paul:** You too. See you later.

**Chandoo:** See you.

So, that’s it. I hope you enjoyed the interview with Paul Woods. I really like the way he shared a lot of information about how to use Word, PowerPoint and Outlook better. As mentioned in the interview, I did not know quite a few things that he mentioned. So, I am glad that I woke up early in the morning to interview him and to learn these things. Go ahead and implement some of these tips. Please visit [http://chandoo.org/session17/](http://chandoo.org/session17/) where you can find a full transcript of this podcast as well as all the links and resources in this episode. Go there to learn more. Please make sure that you implement a couple of tips from this podcast. If possible, I would recommend that you implement all of them so that you can see a boost in your productivity and how you work with MS Office.

Thank you so much for listening and I will meet you again in the next episode. Bye.